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Preface

A. Purpose

This document describes the functionality and procedures involved in using the application 
EVE Screen Editor (ESE).

B. Intended Audience

The intended audience shall be GUI application developers working with EVE products. 

C. Related Documents

Document Name Document Type Document Format

FT81x/BT88x Programming Guide Programming Guide PDF

FT81x Datasheet Datasheet PDF

FT800 Series Programmers Guide Programming Guide PDF

FT800 Embedded Video Engine Datasheet Datasheet PDF

BT81x Datasheet Datasheet PDF

BT81X Series Programming Guide.pdf Programming Guide PDF

D. Feedback

Every effort has been taken to ensure that the document is accurate and complete. 
However, any feedback on the document may be emailed to docufeedback@brtchip.com. 
For any additional technical support, refer to http://brtchip.com/contact-us/.
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Overview

A. Introduction

EVE Screen Editor (ESE) is a GUI tool that provides an intuitive "drag & drop" user 
experience to construct screen design without programming. Empowered by the 
innovative EVE emulator, ESE gives users the maximum fidelity of graphics effect. 

Co-processor commands and display lists can also be provided as input in the editor 
window to construct the desired screen design. As a result, it dramatically lessens the 
learning curve of EVE features.

This tool is platform-independent so the screen design can be created without considering 
the details of the MCU. Users have the option to export the design to hardware platform-
specific source code. This dramatically reduces the effort to start a new project on real 
hardware.

If users have EVE Series board with a cable (FT4222 or MPSSE), the screen design can be 
synchronized with the actual hardware with a few mouse clicks.

Last, but not least, there are more exciting features, such as "tracing and step by step", 
waiting to be discovered. 

Let us get started!

B. Supported Devices

ESE supports all series of EVE chips, including FT80X, FT81X, BT88x and BT81X.
ESE also supports EVE modules which are listed below.

For [Exporting Feature]:

EVE Chip
Family

Platform EVE Modules

FT80X Arduino Projects ADAM_4DLCD_FT843, Breakout_4DLCD_FT843, 
VM800B35, VM800P35, VM800P43_50, VM801B43, 
VM801P43_50

EVE Hal Projects VM800B35, VM800B43_50, VM800BU35, 
VM800BU43_50, VM800C35, VM800C43_50, 
VM801B43_50A

Gameduino2 
Projects

Gameduino2

FT81X EVE Hal Projects ME810A_HV35R, ME810A_WH70R, 
ME810AU_WH70R, ME811A_WH70C, 
ME811AU_WH70C, ME812A_WH50R, 
ME812AU_WH50R, ME813A_WH50C, 
ME813A_WV7C, ME813AU_WH50C, VM810C50

BT88X EVE Hal Projects VM880C(480x272), IDM2040-43A(480x272)
BT815/6 EVE Hal Projects VM816C50A, VM816CU50A
BT817/8 EVE Hal Projects ME817EV, IDM2040-7A
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For [Device Sync]:

Host Platform EVE Modules
FT4222, MPSSE ME817EV-WH70C
FT4222, MPSSE ME817EV-WH10C
FT4222 VM816CU50A
FT4222, MPSSE VM816C50A
FT4222 ME813AU-WH50C
FT4222, MPSSE ME812A-WH50R
FT4222, MPSSE VM810C50A
MPSSE VM800B

C. Key Features

The following are some of the key features of EVE Screen Editor:

WYSIWYG GUI
Support the editing, executing of display list, coprocessor commands
Widget-based GUI construction
Drag and drop to create single screen design
Import EVE specific assets into the project
Export project into source code, C or Python
Sync up the screen design from PC to the connected device
Integrated tools for asset conversion and loading
Inspect the internal registers and memory of EVE

D. 4.9?

Add python-like editor to write a simple emulator based application.
Support "+-*/" (four basic operations) in coprocessor editor/display editor.
Improve content window:

o Add the sorting function in the content window.
o Support multiple files delete in the content window.

Add DXT1 support in image converter.
Add a DXT1_L2_PALETTED format project into example project.
Support C style comments syntax highlight in coprocessor and display list editor.
Add a DXT1_L1_RGB565 example project.
Add DXT1_L2_RGB565 example project.

Enable script editor to load the sample script when it is available in the opened 
project.
Improve the opening and saving script feature of screen editor.
Update the copyright year from 2023 to 2024.
Add one example project "DXT1-FT800" for FT800.
Change the text of the formats in the script editor.
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E. Resolved issues 
 

 CMD_INFLATE does not work as expected. 
 [Save Display List][Save Coprocessor Command] ESE inserts some redundant 

random '0D' bytes into the saved file. 
 [Save Display List][Save Coprocessor Command] The Hexadecimal String notation 

does not apply byte order because the byte order is fixed. 
 [Save Display List][Save Coprocessor Command] The byte order of the saved file 

is incorrect. 
 [Save Display List][Save Coprocessor Command] The name of the saved file does 

not match the entered file name in the input field. 
 Cannot display CMD_TEXT command with EVE HAL library. 
 [Flash Image] Issues with importing flash and undo action after removing file in 

flash image. 
 Cannot click on the point to calibrate using the CMD_CALIBRATESUB command. 
 Show the coordinate on the viewport window when SCISSOR_XY is on focus. 

F. Known Issues & Limitations 
 
The following are some of the known issues and limitations: 

1. CMD_PLAYVIDEO is not supported in device sync up feature.  

2. The Properties window for CMD_LOADIMAGE and CMD_PLAYVIDEO does not display 
a warning message when an incorrect file name is provided. 

3. If an invalid video stream or animation frame is played back, it may lead to ESE freezing 
or becoming unresponsive. 

4. When the REG_ROTATE is changed, the emulator does not allow for item selection on 
the newly rotated screen. Instead, users must select items from the previous position. 

 
Figure 1 - Limitation for item selection on the rotated screen 

5. Script (Python) editor is an experimental feature. 

6. While image files with Unicode file names can be successfully imported into the content 
manager, the export feature lacks support for Unicode in file names. 

7. Export feature may fail if the project file path is more than 255 characters.  
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G. Credits 
 

1. Open-Source Software 
 
 Qt: http://doc.qt.io/qt-6/licensing.html under LGPL. 

 Python: https://www.python.org under GPL- compatible. 

 Pillow: https://pillow.readthedocs.io/en/stable/index.html 

 zlib: https://zlib.net/ 

 libpng: http://www.libpng.org/pub/png/libpng.html 

 FreeType: https://www.freetype.org under GPL license. 

 QScintilla: https://qscintilla.com/ 

 
2. Icons Copyright 
 
ESE utilizes certain icons sourced from http://p.yusukekamiyamane.com/, in adherence to the 
Creative Commons Attribution 3.0 License.  
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Setup & Installation

A. System Requirements

To install ESE 4.9 application, ensure that your system meets the requirements 
recommended below:

RAM: At least 1G RAM

CPU: Multi-core is recommended

Hard disk: More than 500MB of free space

OS: Windows 7 and above, 64-bit platform

Display resolution:  At least 1280 by 800 pixels

We strongly recommend using an administrator user account to run this application.

To work with the export feature, users are recommended to install the following software:

Arduino IDE

Gameduino 2 library

EVE Arduino Library (1.2.0 and above)

Microsoft Visual Studio C++ 2010 IDE or newer is required to compile the HAL 
MSVC projects. 

Microsoft Visual Studio C++ 2012 IDE is required to run HAL BT8xx Emulator 
projects.  

To build and verify projects on Arduino IDE, the following boards are needed:

VM800P/VM801P (3.5", 4.3" or 5.0" display) for exported EVE Arduino library-
based project

Gameduino 2 board with Arduino Pro board for exported Gameduino2 library-based
project
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B. Hardware Requirements 
 
The following hardware can be used to verify the design in the device manager: 
 
Board Host Platform 
ME817EV-WH70C FT4222, MPSSE 
ME817EV-WH10C FT4222, MPSSE 
VM816CU50A FT4222 
VM816C50A FT4222, MPSSE 
ME813AU-WH50C FT4222 
ME812A-WH50R FT4222, MPSSE 
VM810C50A FT4222, MPSSE 
VM800B MPSSE 

 
Note: For VM816C50A, ME812A-WH50R, VM810C50A, and VM800B, a separate USB-
MPSSE adapter is required. 
 

C. Dependencies / Pre-Requisites 
 
 Visual C++ Redistributable for Visual Studio 2017 

 
If the PC does not have Microsoft Visual Studio 2017 installed, Visual C++ 
Redistributable is required. Users can download this from: 
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-
downloads 
 

D. Installing ESE 
 
The following steps will guide you through the ESE Setup/Installation process. 
 

i. Download the installation package from the link https://brtchip.com/toolchains/ 
 

ii. When prompted by a download dialog box, click [Save]. 
 

iii. Navigate to the folder under which the package files are downloaded. 
 

iv. Extract the zip file contents. Double-click the executable file. 
 

v. Select a  for installing the files. Accept the default folder or 
click [Browse] to specify a different location. Click [Next] to confirm the 
destination folder and continue. 

 
vi. In the Select Additional Tasks window, check the Create a desktop shortcut  

checkbox to create the ESE 4.9 icon on the desktop if required. Click [Next] to 
prepare for the installation. 
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vii. Once the initial setup is completed, this screen informs the application is ready to 
be installed. 
 

 
 

viii. Click [Install] to start the installation. A progress bar indicates that the installation 
is in progress. 
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ix. Upon successful installation, click [Finish]. The ESE application UI is displayed. 
 

 
 

E. Installation Folder 
 
The following table provides a list of folders that can be found under the installation path 
upon successful installation of ESE.  
 
Folder Name Description Permission 
Examples The example projects  Read/Write 
imageformats Qt run-time DLLs for image format supporting Read-Only 
Styles Qt DLL for Windows style Read-Only 
Lib Python library Read-Only 
Manual This document Read-Only 
platforms Qt platform run-time DLLs Read-Only 
EVE_Hal_Library The template project Read-Only 
untitled The template project used by export feature  Read-Only 
device_sync Information of built-in and custom boards Read/Write 
export_scripts Python scripts to export project Read-Only 
firmware Flash BLOB for BT815/6 and BT817/8 Read-Only 
iconengines Qt DLL for supporting icon Read-Only 
__pycache__ Created by the Python interpreter Read-Only 

 
Table 1 - Installation Folder 
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  The Graphical User Interface

A. Overview

Figure 2 - Welcome Screen

ESE user interface has the following components: 

Figure 3 - User Interface Components
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B. Menu bar, Toolbar, and Status bar 
 
The menu bar consists of File, Edit, View, Tools, Export, and Help menus, each with a 
drop-down list of available functions. 

 

 
 

 
1. Menu bar 
 
File Menu 
 
The File menu is the first item that appears as part of the menu bar. It contains a list of 
commands that are used for handling files such as New, Open, Save etc.  
 

 
Figure 4 File Menu
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Menu Item Description 
New To create a new project, clear the screen. 

Open To open/ retrieve the existing project. The file extension can be 
".ese", ".ft8xxproj" or ".ft800proj". Example projects can be viewed. 

Save To save the screen design in the user-specified location. The file is 
extension. 

Save As To choose a different destination and file name to save the current 
project. The file is saved with an ".ese" extension. 

Show Welcome Dialog To open the welcome dialog. 

Close Project To close the current project. 

Browse Project Folder To open the project folder where the current project file exists. 

Import To load t  

Export To save what is present in the memory of an EVE chip to a file. 

Save Screenshot To save the snapshot of the screen (i.e. what is currently in use) into 
the local PC. 

Save Display List To save the current display list to a text file or a binary file, in Little 
Endian or Big-Endian format. 

Save Co-Processor 
Command 

To save the current coprocessor command to a text file or a binary 
file, in Little Endian or Big-Endian format 

Recent Projects History 
 

To view the recently opened projects. The latest 5 opened projects 
are added into history list. Clicking the history item will reopen the 
corresponding project again. 

Quit To exit the application. 

 
Edit Menu 
 
The Edit menu contains a list of commands that are used for handling information within 
a file such as Undo and Redo. 
 

 
Figure 5 - Edit Menu 

 
Menu Item Description 
Undo To undo the last action done in the editor. 
Redo To redo the last action done in the editor. 
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Tools menu 
 
The Tools menu contains a list of commands that are used for configuring software such 
as Reset Emulator and Capture Display List. 
 

 
Figure 6 - Tools Menu 

 
Menu Item Description 
Reset Emulator To reset the emulator that is running in the background 
Capture Display List To capture the active display commands from the emulator into the 

editor. 
 
View Menu 

 
The View menu enables users to hide or show the sub windows in 
the editor. Each of the sub windows can be docked to a different 
side of the main window as well as can be a stand-alone floating 
window. Selecting an option ensures that the corresponding window 
is displayed. Clearing the selection hides the corresponding window. 
 
 
 
 
 
 
 
 
 
 
 

Figure 7 - View Menu 
 
Export Menu 

 
Figure 8 - Export Menu 

 
Internally, ESE has a Python engine built-in and employs the Python script to export the 
co-processor commands to a project. 
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For FT80X based projects, there are scripts to export them to Gameduino2, EVE Arduino, 
and HAL based projects. 
 
For FT81X/ BT81X based projects, there are scripts to export them to HAL 2.0 based 
projects. 
 
 
Help Menu 
 

 
Figure 9 - Help Menu 

 
Menu Item Description 
Manual This document 
About Version and copyright disclaimer of ESE and EVE emulator, including 

support and update information.  
3rd Party Credits and copyright disclaimer of third-party software, assets used in 

ESE. 
  
 
2.  Toolbar 
 
The toolbar defines shortcuts of mouse operation for New, Open, Save, Undo, Redo, 
Cursor, Touch, Trace, Edit, Insert, Ruler, Zoom Out and Zoom In functions. 
  

 
Figure 10 - Toolbar 

 
Toolbar Item Description 
New To create a new project. (Clears the editor and starts a new project in a 

temporary directory). 

Open To open an existing project. 

Save To save the current project. 

Undo To revoke the last operation. 

Redo To redo a revoked/ undone operation. 

Cursor Automatic context-dependent cursor switching in viewport. 
 
Cursor mode will automatically switch between Touch/Trace/Edit cursors 
depending on the context and exit a special context-specific mode upon right 
clicking. 
 
Most cursor actions (such as inserting points or trace) can be ended by right-
clicking in the viewport. 
 
Shortcut keys: Alt + C 
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Touch To force touch cursor in viewport. 
 
Enable mouse-click on the viewport to simulate touch action on the touch 
panel connected to EVE touch engine.  
 
Therefore, the touch-related registers are updated in the inspector. It is 
especially useful for CMD_SKETCH.  
 
Shortcut keys: Alt + T 

Trace To force trace cursor in viewport. See Trace the Pixel for more details. 
Shortcut keys: Alt + R 

Edit To force widget editing cursor in viewport. 
Shortcut keys: Alt + E 

Insert To insert duplicates of currently selected widget or primitive at clicked 
position, overrides any current cursor selection. 

Ruler To toggle show/ hide the ruler in emulator viewport. 

Zoom Out To zoom out emulator viewport. 

Zoom In To zoom in emulator viewport. 

Zoom Rate To choose a specific zoom level. 
 
3. Status Bar 
 
The status bar shows the consumption status of RAM_G and RAM_DL as well as bitmap 
handles in the form of percentage. It also shows the cursor position and pixel color in (A, 
R, G, B) format. 
  

 
Figure 11 - Status Bar 

 

When you hover over BITMAP_HANDLE, RAM_DL, and RAM_G, you'll see the ratio of utilized 
resources to the total available. 
 

 

Figure 12  RAM_G Usage on the Status Bar  
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C. Editors and Inspector 
 
This section discusses in detail how the Editors and Inspector  window, which is located 
at the bottom of the main window, functions. 
 
Editor 
 
Editors provide individual windows to co-processor commands and display list commands 
which are sent to the EVE co-processor RAM_CMD and EVE graphics engine RAM_DL, 
respectively.  
 
Please note that the co-processor command editor is the primary editor window since it 
supports the editing of the full command set of EVE, including co-processor commands 
and display list commands. 
 
Inspector 
  
Inspector displays the content of RAM_DL, RAM_REG, RAM_G and RAM_CMD which 
cannot be edited. RAM_DL, RAM_REG, RAM_G and RAM_CMD can be selected line by 
line and then copied to another text editor. 
  

 
Figure 13  Inspector 

 

1. Coprocessor Command Editor 
 

 
Figure 14 - Coprocessor Command Editor 

 
The features are as below: 
  
 Full set of commands support and auto-completion 
 Decimal and hexadecimal values for parameters 
 Error highlights 
 Step-by-step emulation 
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Note: 

 CLEAR command is auto inserted when ESE is launched. 

 CMD_CALIBRATE/CMD_LOGO/CMD_SPINNER commands will pause the following 
commands and shall be the last command in the editor. 

 The terms "RAM_G" and "RAM_DL" are predefined keywords within the editor, and 
they are automatically recognized as referring to the base addresses of RAM_G and 
RAM_DL, respectively.  
 

2. Display List Editor 
 

 
Figure 15 - Display List Editor 

 
The features are as below: 
  
 Display list commands auto-completion 
 Decimal and hexadecimal values for parameters 
 Error highlights 
 Step-by-step emulation 

 
Note: 
 
 Co-processor Command Editor has higher priority, and its content overrides the 

content of the display list editor. To validate the input of the display list editor, ensure 
that the co-processor command editor window does not contain any commands.  

 
 By default, the Display List Editor is hidden. 
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3. Inspector 
 
This section discusses the functions of the Inspector in EVE Screen Editor. 
 

 
Figure 16 - Inspector 

 
RAM_DL 
 
This window reflects the content of the RAM_DL. It shows each 4-byte command in 
hexadecimal as well as text format, from lower to high address. 
 
Please note they are read-only.  
 

 
Figure 17 - RAM_DL 

 
RAM_DL can be selected line by line and then copied to another text editor. 
 

 
Figure 18 - Select Rows in RAM_DL 
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Figure 19 - Paste Selected Rows in RAM_DL 

 
RAM_REG 
 
The RAM_REG window in the Inspector tab shows the register address, register name, 
and current register value in hexadecimal and decimal. 
 
Please note that they are read-only. 
  

 
Figure 20 - RAM_REG 

 
RAM_REG can be selected line by line and then copied to another text editor. 
 

 
Figure 21 - Select Rows in RAM_REG 

 

 
Figure 22 - Paste Selected Rows in RAM_REG 
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RAM_G 
 
The RAM_G window in the Inspector tab shows the data of the RAM_G address and the 
corresponding character value. It provides the ability to jump to a specific address and 
view the Uint value of 4 consecutive bytes. 
 
Please note that they are read-only. 
 

 

Figure 23 - RAM_G 
 
RAM_G can be selected by area and then copied to another text editor. 
 

 

Figure 24 - Area Selection 
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RAM_G can be jumped to a specific address based on the input of user. 
 

 
Figure 25 - Jump to a Specific Address with Decimal 

 

 
Figure 26 - Jump to a Specific Address with Hexadecimal 
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Figure 27 - Jump to a Specific Offset 

 

Figure 28 - Unsigned integer value of 4 consecutive bytes (little endian) 
 

RAM_CMD 
 
The RAM_CMD window in the Inspector tab shows the data of the RAM_CMD address 
and the corresponding character value. It provides the ability to jump to a specific 
address/offset and view the unsigned integer value of 4 consecutive bytes in decimal, 
assuming little endian.  
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Figure 29 - RAM_CMD 
 
RAM_CMD can be selected by area and then copied to another text editor. 
 

 

Figure 30 - Area Selection 
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RAM_CMD can be jumped to a specific address/offset based on the input of user.  
 

 
Figure 31 - Jump to a Specific Address with Decimal 

 

 
Figure 32 - Jump to a Specific Address with Hexadecimal 
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Figure 33 -Jump to a Specific Offset 

 

 

Figure 34 - Unsigned integer value of 4 consecutive bytes (little endian) 
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4. Script Editor 

This is an experimental feature that will help users write scripts to view dynamic/multiple 
screens.   
 
Two types of input are supported: 
 String: Similar to the Coprocessor/Display List editor, ESE executes the commands in 
a string that you transfer. 
 Python: Invoke the commands as Python lib. All commands are added to a list. The 
execute function performs the commands in the list and renders them on viewport. 
 
To use it, please take note of the following: 

 Python is the only language supported in the Script editor. 
 e and use it as below: 

 void init(): Initialize the feature. 
 void reset(): Clear all prepared commands displayed on ESE. 
 int transfer(string): Transfers the commands as a string to the emulator. 

This function will return a negative number when the user has stopped 
executing the script. Therefore, please make sure to check the return value 
of this function to call deinit() and halt the script. 

 int execute(): Push the prepared commands into ESE to display. This 
function will return a negative number when the user has stopped executing 
the script. Therefore, please make sure to check the return value of this 
function to call deinit() and halt the script. 

 void deinit(): Deinitialize the feature. 
 

 

Figure 35 - Script Editor 
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Examples: 
directory. If there is no such file, it uses the default example script in the 

 String and Python are the two options for loading an 
example in ESE. 

 

Figure 36 - Choose an example in a format 
 

Load: Load script from a specific file. 

Execute: Run the script from the Script editor and display the commands in the 
viewport. 
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D. Toolbox, Content Manager, and Registers 
 
This section illustrates the Toolbox, Content Manager, and Register features of ESE. These 
features are available in the window on the left side of the viewport. 
 

1. Toolbox 
 
The Toolbox is the portal to access the co-processor or display list commands. When the 
Display List Editor is in focus, the display list commands are available in the Toolbox. When 
the Co-processor editor is in focus, the full set of display list and co-processor commands 
are available in the Toolbox. Users may drag and drop the commands from the Toolbox 
into the viewport. 
 
Filter 
The toolbox supports a filter powered by regular expression. 
 

 
Figure 37 - Toolbox Filter 

Drag and Drop 
 
The commands in the toolbox can be dragged and dropped in the emulator viewport. The 
editor will be updated with the corresponding commands. 
 
Display List Mode 
 
Select the Display List Editor window to use the Display List mode: 
 

 
Figure 38 - Display List mode 
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The toolbox will be enabled as below:  

     Figure 39 - Toolbox in Display List mode 
 
All display list commands are grouped into various 
categories based on functionality (as in the FT81X 
project):  
 
 Background 
 Primitives 
 Graphic State 
 Bitmap State 
 Drawing Actions 
 Execution Control 

 
 

Figure 40 - Primitives in 
Display List Mode 

Figure 41 - Background in 
Display List Mode 

Figure 42 - Graphics State in 
Display List Mode 
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Figure 44 - Drawing 
Actions in Display List 

Mode 
Figure 45 - Execution 
Control in Display List 

Mode 

Figure 43 - Bitmap State in 
Display List Mode 

 
 
 
 
 

  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Coprocessor Mode 
 
To use the coprocessor mode, the coprocessor editor window shall be selected as shown 
below: 
  

 
Figure 46 - Coprocessor Mode 
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Figure 48 - Background in 
Co-processor Mode 

Figure 49 - Primitives in 
Co-processor Mode 

Figure 50  Widgets in 
Co-processor Mode 

Figure 51 - Utilities in 
Co-processor Mode 

The toolbox will be enabled as below:  

 
Figure 47 - Toolbox in Coprocessor Mode 

 
All commands are grouped into various categories based on functionality. In contrast to 
the Display List mode, the inclusion of Widgets and Utilities categories has been 
introduced. 
 
 Background 
 Primitives 
 Widgets 
 Utilities   
 Graphics State   
 Bitmap State 
 Drawing Actions  
 Execution Control 

 

 

 
 

 

 

 

 

  



 
 

BRT_AN_037 EVE Screen Editor 4.9 User Guide 
Version 1.9 

 
Document Reference No.: BRT_000231   Clearance No.: BRT#160  

 

Product Page                36 

Document Feedback Copyright © Bridgetek Pte Ltd 
 
 

Figure 52  Drawing 
Actions in Coprocessor 

Mode 

Figure 54  Bitmap 
State in Coprocessor 

Mode 

Figure 53 - Graphics 
State in Coprocessor 

Mode 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

  

Figure 55  Execution 
Control in Coprocessor 

Mode 
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2. Registers 
 
This tab is used to set up screen size and macro registers, control Width of HSF and other 
register  value such as REG_ROTATE, REG_PLAY_CONTROL and REG_FREQUENCY. 
The REG_MACRO_0 and REG_MACRO_1 register can be edited in the editor box of 
Macro and the registers should be set using the Display List command syntax. The vertical 
and horizontal size (REG_VSIZE and REG_HSIZE) of the screen can also be edited and 
the viewport will be updated accordingly. 
  

 
Figure 56  Register 

 
ESE can simulate the custom resolution up to 2048 by 2048, which can be done using the 
Register window. However, users shall note that this is for simulation purposes only and 
not for the physical hardware platform. 
 

 
Figure 57 - Customize Resolution in Register Window 
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The screen rotation can be changed using REG_ROTATE. 
 

 
Figure 58  Change Screen Rotation using REG_ROTATE 

 
The playback may be paused or terminated by writing to REG_PLAY_CONTROL. This 

can be controlled in the Control section. 
 

 
Figure 59 - Control Section 

 
There is an option to enable HSF (Horizontal Scanout Filter). The default value should be 
zero, which will disable HSF. Changing the value of this box has the same effect as using 
CMD_HSF. 

 

Figure 60 - Width of HSF Section 
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The main clock frequency can be changed by modifying REG_FREQUENCY. The value is 
in Hz and by default is 60MHz. 

 

Figure 61  The main clock frequency using REG_FREQUENCY 
 

3. Content Manager 
 
This section provides information about the content manager feature of ESE. The Content 
Manager allows users to import the assets (PNG, JPG files, or raw data) on the PC to 
RAM_G by converting the format behind the scenes. 
   

 
Figure 62 - Content Manager 

 
Add the Content 
 
Content Manager enables users to add bitmaps and raw data to be loaded into the specific 
addresses in RAM_G. 
  
To perform this function, follow the steps below: 
  
1. Click [Add] in the Content tab. 
2. The Add Content dialog pops up. Browse and select the file to be added. 
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Figure 63 - Add Content Dialog 

 
Note: The user can drag a content file from the PC and drop it into the Content Manager 
window. 
 
3. Upon adding the content successfully, a green check mark will appear next to the item 

name indicating that the content is available for configuration in the Properties tab. 
  

 
Figure 64 - Content Loaded 
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4. If the content is an image, the user must specify the 

converter type as "Image  specify the desired 
output format for conversion. 

 
The user can also specify where to store the converted 
image data in RAM_G through the Memory options, or 
in flash storage through the Storage options. Please 
note that the converted data is stored in the same 
directory as the original image. 

  
Note: Only ASTC format can be loaded from flash 
storage directly. 
 

5. If the content is raw data, simply select the "Raw" 
option in the Converter drop-down menu since 
already converted raw data does not need further 
processing. Upon loading the data successfully, users 
can specify the offset of raw data in the "Start" edit 
box as well as the length of data to be imported in the 
"Length" edit box. 

 
 

 

                                                                                              Figure 65 - Content Properties 
 

 
Figure 66 - Raw Converter 

  
6. Upon image conversion, users can drag the image from the Content Manager and 

drop it into the viewport. 
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Figure 67 - Drag Content into Viewport

After placing the image, the display list will be generated in the editor automatically and
appended after the currently focused command.

Remove Content

Users may remove the selected bitmap or raw data in the content manager and clear the 
content manager.

To remove added content: 

Select the content to be removed and click [Remove].

Figure 68 - Remove Content

The selected content is then removed from the list.
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Rebuild the Content 
 
If the source file of the content has been marked as out of date, users need to rebuild it. 
 
Convert the Content 
 
The following information is for users who want to program EVE directly.  
Currently, ESE is using the utilities: FreeType, libpng, pngquant, ASTC Encoder.  
These utilities are not required to use in the ESE, but they help convert the resource to the necessary 
files that EVE can understand. 
 
For each valid resource in the Content Manager, the utility converts it to the below file 
formats: 
 
*.raw The binary format of the converted file can be downloaded into RAM_G 

directly. 

*.rawh The header file of the converted file is in the text representation. 
Programmers can include this file into their program and build it into the 
final binary. 

*.bin The compressed binary format of converted file in ZLIB algorithm. 
Programmers need to download it into RAM_G and use CMD_INFLATE to 
inflate them before using it.  

*.binh The header file of compressed binary format, which is in the text 
representation of *.bin. Programmers can include this file into their 
program and build it into the final binary.  

*.meta The file stores the basic information of a content item. It helps to check 
whether the utility should convert it again.  

*.json The file stores the information of the converted image. 

*_Converted.png, 
*_fs8.png 

The file is generated from the image through the utility when the converter 
is Image. 

* _converted.png The file is generated from the font through the utility when the converter 
is Font. 

 
If the palette image format was chosen, files with the .lut  text in the file name are 
generated and the appropriate file should be downloaded into RAM_PAL for FT80X, or idle 
area in RAM_G for FT81X and later. 
 
The generated files are in the directory mentioned in the "Information" section of the 
resource "Properties" tab. 
 
These original and converted files are stored in the following folders: 
 
resources Stores the original files 
images Stores the converted files when the converter is Image or Image 

Coprocessor 
font Stores the converted files when the converter is Font 
content Stores the converted files when the converter is Raw 
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Figure 69 - Structure of a Project 
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E. Devices, Controls, Properties, and Output 
 
This section illustrates the Controls and Properties tab in the EVE Screen Editor. 
 
1. Device Manager 
 
The Device Manager enables the user to connect the EVE board with the PC and directly 
observe the design on the EVE board hardware. 

 

 
Figure 70 - Before Connecting 

 
 

 
 

Figure 71  Connected Device 
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The device type can be changed by clicking the Settings icon and then selecting the correct 
display device type. Built-in devices are displayed in bold font and custom devices are 
displayed in regular font. 

 
Figure 72 - Device Type 

 
Note: The Horizontal and Vertical input fields in the Registers dock change the View Port 
dimensions only. The display configurations when syncing with the device are determined 
by the selected display device type.  
 

 
Figure 73 - Device Settings 
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2. Controls 

 
In the Controls tab, users may execute the code step by 
step according to the granularity of the display list 
command or coprocessor command. 
 
See the "Steps" grouped widgets in Figure 72.  
 
As a result, the step-by-step construction of the screen can 
be viewed by increasing or decreasing the value of the display 
list or coprocessor input box. 
 
Only one option can be selected at any given point of time 
and the respective tab must be focused. Refer to Step by 
Step section for more details.  
 

                                                                                                      Figure 74 - Controls Tab 
 
Users may also trace which commands are involved to render the pixel at the specified 
coordinator.  
 
See the "Trace" grouped widgets in Figure 72. Refer to Trace the Pixel section for more 
details. 
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3. Properties 
 

The Properties tab provides information as well as 
the available editable parameters of the selected 
commands and components. Different commands 
have different properties. These parameters can be 
edited either in the Properties tab or in the Code 
Editor. 
 

 
 

 
 

 
 
 
 
 

                                Figure 75 - Properties Tab 
 

 
 

The Properties tab also provides information about 
the content item in the Content window. 

 
 
 
 
 
 
 
 
 

 

4. Output 

Warning and error messages will be 
displayed in the Output tab. 

 

                                                            Figure 76 - Output Tab 
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F. Viewport 
 
This is the significant area in the center of the screen. When the user selects any 
components or commands in the Toolbox, those components can be visually seen in the 
viewport. The viewport has the same resolution as specified in REG_HSIZE and 
REG_VSIZE. 
 

 
Figure 77  Viewport  

 

G. Navigator 
 
The viewport navigator provides a convenient way to move the viewport, especially for 
large resolutions.  
 

 

Figure 78  Navigator 
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H. Project Settings 
 
Within this tab, the user can select chip type and corresponding screen resolution for the 
current project.  
 

 
Figure 79 - Project Settings 

 
Since BT81X, flash images are supported. To load a flash image, click the Browse button 
and select a flash map file on a local PC. 
 

 
Figure 80 - Flash Is Supported 
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I. Keyboard Shortcuts 
 
The following keyboard shortcuts can be used in the Eve Screen Editor: 
 
Item  Shortcut 
New Ctrl + N 
Save Ctrl + S 
Undo Ctrl + U 
Redo Ctrl + Y 
Cut Ctrl + X 
Copy Ctrl + C 
Paste Ctrl + V 
Zoom In/Out of Viewport Ctrl + Mouse wheel 
Close Project Ctrl + F4 
Reset Emulator Ctrl + R 
Capture Display List Ctrl + D 
Open Recent Project 1->5 Alt +  
Toolbar Cursor Alt + C 
Toolbar Touch Alt + T 
Toolbar Trace Alt + R 
Toolbar Edit Alt + E 
Open Project Ctrl + O 
Open Welcome Dialog Ctrl + Alt + W 
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Quick Start Tutorials

This section explains how to use the EVE Screen Editor. They are intentionally kept brief 
so that the user can start using the editor as quickly as possible. The objective is not to 
teach the user every single detail, but to help the user to get familiarized with the basic 
principles and the way the editor works.

A. Capture Display List

To capture the display list, select Tools -> Capture Display List, or use the shortcut 
Ctrl+D. For example, users can type "CMD_TEXT" in the co-processor editor, then press 
Ctrl+D. The Display List commands will be displayed.

B. Change Color

Subsequent drawing color can be changed by several methods: 

Drag and drop method of the Color RGB command, under the Graphics State group in 
the Toolbox to the viewport and then by choosing the desired color in the Command 
Properties or by editing the command values in the command output.

Input the commands and then change directly in the editor.

Figure 81 - Change Drawing Color
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The Properties tab of the Color RGB command can change the color visually by clicking the 
color bar and selecting a color. 
 

 
Figure 82 - Select Color 

  
In the EVE code syntax, the following commands have the color channels as their 
parameters (in the order of Red, Green, and Blue): 
  

 COLOR_RGB 
 CLEAR_COLOR_RGB 
 CMD_GRADIENT 
 CMD_BGCOLOR 
 CMD_FGCOLOR 
 CMD_GRADCOLOR 
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C. Import Content

Importing the content adds the bitmap or raw data to the Content tab. The data added 
will be listed in the Content tab and can be used in the construction of display screens by 
dragging and dropping the data into the viewport. The raw and bitmap data can be added 
to the list as explained in the Add Content section. The added data can be removed by 
selecting an entry and clicking [Remove] in the Content tab. 

Figure 83 - Import Content

If the added content is an image, select the "Image" mode of Converter in the Properties 
tab:

Figure 84 - Select Converter Image
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Upon adding the image data successfully, the image can be dropped in the viewport by 
dragging the content name from the Content Manager to the viewport. The display 
commands are generated automatically. 

Figure 85 Drag & Drop Image
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D. Import Flash 
 
Importing the flash adds resources such as movies, images, font, etc. The added data is 
formatted as raw and loaded into flash memory. 
 
Their flash addresses can be used in the Display List and Co-Processor commands. 
 

 

 
 
  

Figure 87 - Import Flash 

Figure 86 - Flash Address 
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E. Open a Project 
 
To open a saved project, simply click Open on the toolbar, or select File -> Open from 
the menu bar and browse for the saved project.  
 
Note: 
 
ESE Version 2.X is still able to open 1.X project file with the ".ft800proj" extension name. 
 
ESE Versions 3.X and higher are still able to open 1.X and 2.X project files with ".ft800proj" 
and ".ft8xxproj" extension names. 
 

 
Figure 88 - Open Project 

 
ESE Versions 4.4 and higher support opening a project using drag and drop events. Users 
can drag and drop a project folder or a project file (*.ese) into ESE to open that project. 
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F. Save Your Design 
 
The current project can be saved by: 
 

 clicking [Save] on the toolbar 
 or selecting File -> Save 
 or pressing Ctrl+S keyboard shortcut 

 
Users can also save the current project as a different filename and/or in a different 
directory by selecting File- > Save As. 
 
Please note saved project files have an extension of .ese. 
 

 
Figure 89 - Save a Project 

  

G.  Export a Project 
 
Users can export their screen designs in various formats such as Gameduino 2 project, 
EVE Arduino project, EVE HAL2.0 project (C code based), and Raspberry Pi Pico project. 
Once the export process is complete, the Properties dock continues to display the project 
output information until the user interacts with the application again. 
 
As the export feature involves writing files to the disk, users must ensure that they have 
appropriate privileges to use EVE Screen Editor. This may require running the tool as an 
Administrator. 
 
It should be noted that while the Content Manager does not enforce a strict naming 
convention on loaded items, during the export process, the names should be distinct and 
follow the variable naming convention used in the C programming language. 
 
To export the project, follow the steps below: 
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1. Click Export menu in the menu bar. 
2. Select the option to which the project is to be exported. 

 

 
Figure 90 - Export Project 

  
For the "EVE HAL2.0 project", a file browser opens after the generation, and the 
ReadMe.txt in the project folder details the project directory files.  
 
For "Gameduino2" and "Arduino" projects, the project files will get generated and opened 
by Arduino IDE, if the Arduino IDE is installed. The Arduino project file extension ".ino" is 
associated with the Arduino IDE. Please note Gameduino2 EVE library and Arduino library 
are required to compile and build the project. 
 
Users are required to read the datasheet of Gameduino2 for hardware connection 
information. 
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Figure 91 - Arduino IDE 

 
For Raspberry Pi Pico projects, the project files will be generated in a separate folder which 
will  and , and .  
 
Users need to read the  that explains each item as well as the 
circuitPython firmware version, hardware connection information, and some useful links. 
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Figure 92  Export Raspberry Pi Pico Project 

  

H. Custom Fonts 
 
ESE supports generating EVE specific custom font by importing the widely used fonts, such 
as TrueType fonts (TTF) and OpenType font (OTF). The widgets in the Toolbox can only 
support non-kerned fonts. Kerned fonts can still be displayed if they are drawn individually 
as bitmaps. The Examples folder contains multiple custom fonts and using non-kerned 
fonts is as simple as loading bitmaps.  
 
To use custom fonts, refer to the following two figures and these steps: 

1. Load the custom font in the Content manager. Successfully loaded fonts have the 
"Loaded" status indicated beside their font names.  

2. Set the font format and size attributes. 

3. Drag and drop the font into Viewport. 

4. Click the font object in the Viewport to edit the commands. 

5. "CMD_SETFONT" and "CMD_SETFONT2" are generated accordingly for FT80X and 
FT81X/BT81X devices to assign the new custom fonts with one unused bitmap 
handle. By default, the first unused bitmap handle is zero. 
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Figure 93 - Custom Font

Figure 94 - "Text" Property of a Custom Font
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I. Placement Assistance  
 
1.  Restrict Vertical Placement 

 
1. Align two objects that should share the same x-coordinate alignment. 
2. Hold down the SHIFT key and click the aligned object. 
3. Move it vertically along the dashed red line. 

 

 
 

Figure 95 - Hold Down the SHIFT Key to Lock Vertical Movement 
 
 

 
 

Figure 96 - Move the Selected Object Vertically Along the Dashed Red Line 
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2. Restrict Horizontal Placement 
 
1. Align two objects that should share the same y-coordinate alignment. 
2. Hold down the ALT key and click the aligned object. 
3. Move it horizontally along the dashed red line. 

 
Figure 97 - Hold Down the ALT Key to Lock Horizontal Movement 

 

 
Figure 98  -  Move the Selected Object Horizontally Along the Dashed Red Line 
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J. Automatically Detect and Load Content 
 
When a user adds an asset from the list of supported files to the Content window, ESE will 
automatically read the corresponding file (.json/.readme) located in the same folder to 
gather essential information. This information will then be configured in the Properties 
window. 
 
The supported files are listed as below:  
 .ram_g (animation), .flash (animation)  
 .raw (image), .raw (font legacy format)  
 .glyph (font extended format), .xfont (font extended format) 

 

 

Note: 

 For image with PALETTED format, ESE will try to add both the LUT file and the 
INDEX file.  

 For font with Extended format: ESE will try to add both the .glyph file and the .xfont 
file. 

 Therefore, please make sure that you are keeping them in the same folder or in 
the original folder structure generated by EAB tool.  

Figure 99  Retrieve Meta Data of Asset  
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K. Generate Coprocessor Commands for Item 
 
After the user has dragged and dropped an item from the Content Manager into the 
viewport, ESE extracts the relevant information from the JSON file (located in the same 
directory). Subsequently, ESE generates the corresponding coprocessor commands to 
render them. 
 

 

 
Supported assets: 
 Video (.avi file)  
 Bitmap (.raw file) 
 Font (.raw or .xfont file)  

  
  

Figure 100 - Automatically Generated Coprocessor Commands 
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L. Overlay Extra Lines in Viewport to Assist Graphics Alignment 
 
ESE displays alignment lines to help the user align a graphic item when its position is close 
to the vertical or horizontal edges of other graphic items. 
 
Green: Vertical match 
Cyan: Horizontal match 
Red: Nearly vertically 
Dark yellow: Nearly horizontally 
 

          

Figure 101 - Nearly Vertically and nearly Horizontally 
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Figure 102 - Vertical Match and Horizontal Match 
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Example Project Explanation

ESE provides a set of example projects to showcase the different features of EVE.  Users 
are encouraged to explore these example projects to learn more about the functionality of 
EVE as well as the usage of ESE
button in the Welcome dialog box as below: 

Figure 103 - Overview Dialog

Figure 104 - Example Dialog

When the mouse hovers over the screenshot of an example project, its brief introduction 
will be shown. Click the screenshot and the example project will be launched. 

In this chapter, several example projects have been carefully chosen to explain in more 
detail, which could help users understand more about the EVE chip and ESE tool.
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A. ASTC format Example project 
 
This example showcases the same image in different ASTC formats. 
 

 

Figure 105 - ASTC Format Example Project 
 
The example loads the mapped flash image to get a list of items as shown below.  
 

 

Figure 106 - Construction of ASTC Format Example Project 
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Based on the information of the content item, the example uses the appropriate commands 
to display the image. 
 

 
Figure 107 - Use Commands and Assets to Display Content with ASTC format 

 

B. Setfont2 Example Project  
 
This example showcases the usage of cmd_setfont2. 
 

 
Figure 108 - Setfont2 Example Project 
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Figure 109 - Use Commands and Assets to Display Font 
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C. Transparent Button Group Example Project 
 
This example showcases a group of transparent buttons. 
 

 
Figure 110 - Transparent Button Group Example Project 

 

 
Figure 111  Construction of Transparent Button Group Example Project 
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Figure 112  Create Background 

 

 
Figure 113  Create Button Background 
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Figure 114 - Complete the Example 
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Working with ESE

This section provides information about the usability of EVE Screen Editor.

A. Connect with Hardware

Once the user has designed the screen on the PC, if the user has the board connected to
the PC, the device manager can be enabled to observe the effect on actual hardware.

Figure 115 - Connect Device

Upon clicking [Connect] button, the device is ready to be synchronized with the Screen 
Editor. 

Note 1: USB Hub may cause a failure in connection with the FT4222 module. So, in case 
of using the FT4222 module, please do not use USB Hub for connection.

Note 2: Do not forget to click this icon to select the correct device type.

Figure 116 - Device Connected

If the project loads content from a flash image, we need to write flash first by clicking 
[Write Flash Content].

[Upload RAM_G and RAM_DL] is used for synchronizing Display List while [Upload 
RAM and Coprocessor] is used for synchronizing Coprocessor command.
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Note 1: Ensure that the connected device (1) has the same EVE chip as the selected 
emulator (2). See the figure below. 
 
Note 2: In case there are content items currently stored in flash, it is better to [Write 
Flash Content] before any update. 
  

 
Figure 117 - Select the Correct Device Type 

 
Managing Device 
 
There are two kinds of devices:  
 

 Built-in Device: Users can examine and clone these devices. They cannot be 
modified. 

 
 Custom Device: Users can Add/Edit/Clone/Remove a device. 

 

 
Figure 118 - Managing Device 
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B. Check Your Design 
 
This section explains how to validate your design. 
 
1. Step by Step 
 
Users can select to execute the display list or co-processor command step by step to 
observe the effects of the commands up to that point. The increase or decrease in the 
value of the display list and co-processor input box will execute the specified steps and 
highlight the specific display list or co-processor commands. 
  

 
Figure 119 - Select Display List/Coprocessor 

 
Refer to the figure below. The 2nd display list command is highlighted by a yellow line but 
there is nothing drawn in the viewport because the VERTEX2II command has not been 
executed yet.  
  

 
Figure 120 - Display List Command is Highlighted in Yellow 
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Figure 121 - Prepare to Draw a Rectangle 

 
If the user increases the value in the Display List input textbox, the highlighted line will 
be moved, and the effect of the drawing is shown below: 
 

 
Figure 122  Draw Rectangle 

 
2. Trace the Pixel 
 
Users can check what commands or display lists are involved in the drawing of the pixel 
by selecting a coordinate in the viewport with the Trace mouse command. The movement 
of the Trace in the viewport is updated in the Trace section of the Control tab. If an 
object(s) occupies the tracing coordinate, then the respective command(s) in the 
commands editor is highlighted in green. If there is more than 1 object occupying the 
trace coordinate, the topmost object will get highlighted in a brighter green instead of 
those under it. 
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Figure 123 - Trace the Pixel 

 

C. Example Project 
 
The examples are easily accessible from the "Examples" folder in the installation directory. 
They can be opened in the screen editor using File -> Open.  
 
The Examples folder contains four sub-folders BT81X , FT81X , and FT80X  
for specific example projects:  
 

 
Figure 124 - Examples 
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Open "allwidget_NoScreenSaver" project under FT80X folder and it will show:  
 

 
Figure 125 - Open an Example Project 

D. Add Software Library for Exporting Projects 
 
You can expand the functionality of ESE by including an additional Python file to integrate 
your custom software library for your specific hardware platform. 
 
To incorporate a custom library into the Export menu, simply place the files of your module 
with the module name in the following directory within the installation directory: 
/export_scripts/<device_type>/<library_name>/<module_name>.py  

 
Note 1: If the device type is labeled with a generic name, the modules will be visible to 
all models falling under that type. For instance, if the <device_type> is configured as 
"bt88x," selecting "bt881" in the device type section of the project configuration window 
in ESE will also reveal the export menu. Please make sure to specify the chipset name as 
the device type when working with a particular chipset. 
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Figure 126  Directory structure for a software library containing modules 
 

 

Figure 127  The software libraries of Export feature are displayed on the ESE interface 
 

Note 2:  Define the callback functions for ESE to invoke.  
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Figure 128 - An export script 
 
In your custom module file <module_name>.py, the following 2 functions are 
mandatory and must be defined properly: 
 

 displayName():  The function that returns a string, normally the module name, 
which will display on the menu of ESE. It will be triggered when 
a user clicks the Export menu and hovers the mouse over the submenu. 

 ..):  The entry function that ESE invokes to carry out the export task. 
 
When BT81X is chosen as the device type, the following function signature is 
anticipated:  

run(name, document, ram, screenResolution) 
 

      Otherwise, the function below is expected:  
run(name, document, ram) 

 
where 
name    : Project name. A string object. 
document : All information about the current device  

  (device model, register, display list, coprocessor).  
  A string object in json format. 

Ram    : Ram of the device. A byte array object. 
screenResolution: Resolution of the screen (Example: 480x272). A string object. 
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Figure 129 - Export Projects from  Software Library 
 

 

Figure 130 - Add Module Name Files to Installation Directory 
 

 

Figure 131 - Export Scripts 
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E. Working with EVE Asset Builder 
 
When a user adds an image, a font or an animation generated by EVE Asset Builder (EAB) 
to the Content window, ESE will automatically gather the necessary information from the 
information file. This information facilitates the modification of values in the Properties 
window and the generation of commands when the user places the content item into the 
viewport. 
 
1. Load Image 
 
Add an image(.raw) generated by EVE Asset Builder (EAB) to the Content window. ESE 
will automatically gather the necessary information from the .json file.  
 

 

Figure 132 - EAB - Image Converter 
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Figure 133 - EAB - Output of Image Converter 

 
 

e  
Figure 134 - Add the Image into Content Window 
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2. Load Font 
 
Add a font with legacy format (.raw) generated by EAB to the Content window. ESE 
will automatically gather the necessary information from the .json file. 
 

 
Figure 135 - EAB - Font Converter with Legacy Format 

 

 
Figure 136 - EAB - Output of Font Converter with Legacy Format 
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Figure 137 - Add a Legacy Font into the Content Window 
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Add a font with extended format (.xfont and .glyph) generated by EAB to Content window. 
ESE will automatically gather the necessary information from the .json file. 
 

 
Figure 138 - EAB - Font Converter with Extended Format 

 

 
Figure 139 - EAB - Output of Font Converter with Extended Format 
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Figure 140 - Add the Extended Font into Content Window 

  



 
 

BRT_AN_037 EVE Screen Editor 4.9 User Guide 
Version 1.9 

 
Document Reference No.: BRT_000231   Clearance No.: BRT#160  

 

Product Page                91 

Document Feedback Copyright © Bridgetek Pte Ltd 
 
 

3. Load Animation 
 
Add an animation (.anim.flash and .anim.ram_g) generated by EAB to the Content 
window. ESE will automatically gather the necessary information from the .json file (or 
.readme with older versions of EAB files). 
 

 
Figure 141 - EAB - Animation Converter with Flash Address 

 

 
Figure 142 - EAB - Output for Animation Converter with Flash Address 
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Figure 143 - Add the Animation with Flash Address into Content Window 
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Figure 144 - EAB - Animation Converter with RAM_G Address 

 

 
Figure 145 - EAB - Output for Animation Converter with RAM_G Address 
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Figure 146 - Add the Animation with RAM_G Address into Content Window 

 
4. Load Flash Image 
 
Flash image (.bin) and flash map (.map) are generated by another tool called EVE Asset 
Builder whose latest version is available at this link - https://brtchip.com/ic-
module/toolchains/#EVEAssetBuilder. 
 
Follow these steps to generate a flash image: 
 

1. Open the EAB tool. Switch to Flash Utilities tab. 
2. Add necessary asset files. 
3. Set output folder and output name for the flash image. 
4. Press [Generate] button. 
5. Generated files are saved in the output folder. 
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Figure 147 - Flash Image Generation by EAB 

 

 
Figure 148 - Generated Files in Output Folder 

 
.bin  file is a binary file that can be loaded into an emulator as well as a flash chip. 

lash.map  and .edf  are human-readable text files. Each line shows the asset 
name, the beginning address, and the length. 
 

 
Figure 149 - Content of .map File 
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Figure 150 - Load Flash File 

 
Users can select flash memory value from 8MB to 256 MB. 
  

 
Figure 151 - Select Flash Size 

 
Upon loading the flash file, its path is displayed. 
      

 
Figure 152  Display Flash Path 

 
All the assets in a flash file are loaded and shown in Content window. 
 

 
Figure 153 - Flash Assets are Shown in Content Window 
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Disclaimer

This section contains the license agreements of ESE. Any other third-party software or 
artifacts included in the software are listed under Help -> 3rd party.

Disclaimer

Neither the whole nor any part of the information contained in, or the product described 
in this manual, may be adapted, or reproduced in any material or electronic form without 
the prior written consent of the copyright holder.

This product and its documentation are supplied on an as-is basis and no warranty as to 
their suitability for any particular purpose is either made or implied. Bridgetek Pte Ltd will 
not accept any claim for damages howsoever arising because of use or failure of this 
product.

Your statutory rights are not affected. This product or any variant of it is not intended for 
use in any medical appliance, device, or system in which the failure of the product might 
be expected to result in personal injury. This document provides preliminary information 
that may be subject to change without notice. No freedom to use patents or other 
intellectual property rights is implied by the publication of this document.
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Contact Information

Refer to https://brtchip.com/contact-us/ for contact information.

Distributor and Sales Representatives

Please visit the Sales Network page for the contact details of our distributor(s) and sales 
representative(s) in your country.

System and equipment manufacturers and designers are responsible to ensure that their systems, and any Bridgetek Pte Limited 
(BRTChip) devices incorporated in their systems, meet all applicable safety, regulatory, and system-level performance 
requirements. All application-related information in this document (including application descriptions, suggested Bridgetek 
devices, and other materials) is provided for reference only. While Bridgetek has taken care to assure it is accurate, this 
information is subject to customer confirmation, and Bridgetek disclaims all liability for system designs and any application
assistance provided by Bridgetek. Use of Bridgetek devices in life support and/or safety applications is ent
and the user agrees to defend, indemnify, and hold harmless Bridgetek from any damages, claims, suits, or expenses resulting 
from such use. This document is subject to change without notice. No freedom to use patents or other intellectual property rights 
is implied by the publication of this document. Neither the whole nor any part of the information contained in, or the product 
described in this document, may be adapted, or reproduced in any material or electronic form without the prior written consent 
of the copyright holder. Bridgetek Pte Limited, 1 Tai Seng Avenue, Tower A, #03-05, Singapore 536464. Singapore Registered 
Company Number: 201542387H.
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Appendix A - References 
 

Acronyms & Abbreviations 
 

Terms Description 

CPU Central Processing Unit 

DLL Dynamic Link Library 

ESE EVE Screen Editor 

EVE Embedded Video Engine 

GUI Graphical User Interface 

GPL General Public License 

HAL Hardware Abstraction Layer 

IDE Integrated Development Environment 

LGPL Lesser General Public License 

MCU Micro Controller Unit 

MPSSE Multi-Protocol Synchronous Serial Engine 

OS Operating System 

RAM Random Access Memory 

UI User Interface 

WYSIWYG What You See Is What You Get 

EAB EVE Asset Builder 
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